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jie ¥8.5 of the Bace Technology software — InstallShield Wizard

Welcome to the InstallShield Wizard for ¥8.5
of the Race Technology software

The Installshield{R) wizard will install ¥5.5 of the Race
Technalagy software an wour compuker, To cantinue, click
Mek,

WARMNIMG: This program is protected by copyright law and
inkernational treaties,

%]

< Back [ Dext> [ Cancel




1. &A] - 4 AZEQ9 A rEasST

License Agreement T _ ‘ .
Please read the Following license agreement carefully, @-;{*
RACE TECHNOLOGY LTD -

Software License Agreement

Flease read the following software license agreement. Use the scroll bar ta
view the rest of the agreement.

RACE TECHMOLOGY LTD., software license agreement important: do not

click on the "next" button until you have read this agreement. By clicking an
the "next" button, you accept all of the terms of this agreement. If you do not
accept all of the terms of this agreement (1) da not click an the "next” buttan,

(#)1 accept the kerms in the license agreement;

{1 do not accept the terms in the license agreement

< Back Mext > Cancel |

32S MHESIY Nexts MEEYH.
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¥ ¥8.5 of the Bace Technology software - InstallShield Wizard [Z|
-~

Destination Folder 1
"‘"l::?!. h
lick Mext to install to this folder, or dick Change ko install to a different Folder, ﬁ‘"ﬂ'

-y

Install ¥8.5 of the Race Technology software ko:

i WProgram Files WRaceTechnologyys, S

< Back Cancel

[

NextS MEEYC.
N2XO=E (G| Program File otF°| 267 YYEHH. GE MI2LA=R2 HAF Y ¢ HESIA

=L
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e RaceTechnologyV8.5 - InstallShield Wizard

Select applications to install

Select a lisk of applications that best suits wour needs

Flease select an option: I{:} Inskall all racing s::nFtwarel

|{:} Install all industrial su:uFtwarel

() Install only DASH4PRO software For industrial use
() Install only the DASHE software

{3 Install only Run Processar software

< Back ]| Mext > [ Cancel

RS M8o| WEE MeErBHC



1. 8 - 7 94 IE M

RACING SERVICE.KR
\

i@ BaceTechnologyV8.5 - InstallShield Wizard

¥ideo Mode

Select the default video mode

Default Yideo Mode: (I WNTSC

This is the videno standard used in US4

This is the video standard most widely used outside
af the LISA

< Back Mext > Cancel |
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% BaceTechnology¥8.5 - InstallShield Wizard
Run Database and Swap File Paths

Select the directories for Run Database and analysis Swap file
Fun Database Path
Please specify the root directary where you want the run database to be stored. This is the

default location where all your daka is stored, inchading run data files, video files, lawouk files,
wariable files etc, Ik should be a location on your PC which has lots of free capacity

| ¥Dacuments and Settings Wl Usersapplication Data'WRace Technolagy Y. SR |
Swap File Path and Size

Please specify the location and size of the swstem swap file, This is a file that is used ko hold all
kemparary daka from analysis. The file should be sized to hold the maximum amount of data

khat wou think wou will every wank to load at the same kime, Ideally this should be placed on
wour Fastest local hard drive, and certainly not on a network drive

| Documents and SettingsWall UsersWapplication Data'WRace Technology ¥&.54 |
16636 {approximately & hours)

1GE {approximately 30 minukes)
2GE {approximately 1 hour)

W

[ Reset to defaulks ]

< Back [ Mext > ] [

Cancel ]
3256 (approximately 16 hours)

SEOIAIT pce MEF §FO| TEZ

NextS MEZHC.
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iiw ¥8.5 of the Bace Technology software — InstallShield Wizard [z|
' N

Ready to Install the Program K
L "‘1‘1 b
The wizard is ready to begin installation, m?"

o |

Click. Install to begin the installation,

If wou wank to review or change any of vour installation settings, click Back. Click Cancel to
exit the wizard.

< Back Install

Cancel

Install2 {MEISLICE,
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ji? V8.5 of the Bace Technology software - InstallShield ... |-_||_.f'>_<|
Installing ¥8.5 of the Race Technology software . '. "
The program Features you selecked are being installed, ' A i"::r?_ﬂ

Please wait while the InstallShield Wizard installs ¥8.5 of the Race
Technology software, This may take several minukes,

Skakus:

Removing Folders

< Back Mexk = Cancel

A Y 5 E4HH.
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jie ¥8.5 of the Bace Technology software — InstallShield Wizard |E|

InstallShield Wizard Completed

The Installshield Wizard has successfully installed w&.5 of the
Race Technology software, Click Finish bo exit the wizard,

[] B0 vou want to start the analysis software now?

[ ] would vou like to read the release notes for this
WEFSIon?

< Back Finish Zancel

8N 25E ¥ FinishE MEEYH.
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Input Component Data Logger Yideo system

(T
Configure Configure Configure

() Race Technology software
) Legacy Race Technalagy programs

Help me to configure the whole

spstem

Select the components used in your da
systern, Configure each component in t
using the component specific software,
transferting the settings to the unit,

Race Technolo
Tel Uk +4d(D)l‘??r3 537 B20
Tel US: +1 804 353 7289
Sales sales@race technologgI com

Help File
Knowledgebase upport

_- _- __ : INm Device Explorer & & Team\Viewer @
iew data in real #ime _ Download data e Interachive suppaort

Wiewand analyl! .
averserial partfUS8 L over USH connection from Race Technology

previously logged data

Build b

RaceTechnology 38 3tMO| EAIZIM XM HAIE Analysis € MEIZLC.
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So we can keep vou informed of any software or firmware updates pleaze enter you email address. Mote that thiz email
addrezs will not be pagzed to any 3rd partiez and there i no charge whatzoever for uzing or registenng this zoftware.

Email address:

If you have already been emailled a pin number, pleaze enter it here: I:I

I| Cancel ’ Reqgizter now

N&M2 e-mail FAZ RHSW PIN NUMBERS RO HAM AfLigo] AL,

ul
HHEDD WhE= % CancelZ2 MESID TJYFHH.



2. 2% -4 Z=1

O%

75

RACING SERVICE.KR
\

Generating new swap file

& niew zwap file iz being generated, thiz iz the file where all
temporary data iz held. Thiz process iz only done when analyzis iz
ruin for the first time, if the swap file zsize i changed, or if there iz
an ermar in the file. Thiz process can take some time during which
the pc may not be responsive - please be patient!

Swap Dol ¥o=HE= 2 BA NHEYHH.
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Welcome to the Bace Technology data analysis software!

Thiz appears to be the first time that analvziz haz been run on this po, or it is —— -‘
a new installation. Do you wish bo configure the software with details of your . '*-.::_"1 .
Car oy

Y'es pleazel Letz go... Mo thanksz! I'll zet the software up nest time

1] . .
N':f th‘mks' Il set H?E S':'H;“ar?t’ uﬁ m-"'tsh?" | would like bo get my settings from the
using the menus, please don't shaw this e i N R
wizard again.

50| 2B ¥ AWM HeZE 9lo FOIN My EAE
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|_~i_| Fieztart lazt session

@, Load a run from memony card, with the
o O

default lapout

Load a run from memony card

Start a blank zession, but with the
default layout
Start a blank sezsion |

Load a previously zaved session ‘

&

I on't ask me again, do thiz action eveny lime

SHM HQEL 9o AON MM EAE £ RE SISE ML
MAY ALY MEL A, Race TechnologyolM At 21 o2 35ehy o,
AN MY ME A HOIE BB S U
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Y Analysis - 8.5.330

2N Data  Hesults  Window  Help

Load logged data ES @ M Ilﬂl

Load data from database

KE @

Advanced load/saves k

Set serial port
Download data

Export as data,,,
Export as video, .,

Print setup
Brint, .,
Frint all, .,

set default paths et defa directo
Format flash card

Reset to factory settin Run files: |D:“~ L Change.. J
Change swap file
Session files: ||:| Change..

Exit
Ewport ko ||::"~ Change..
[ Ok, ] [ Cancel ]
Select directory
EE Y]
e
3 Documents and Settings
5 Adrministratar
(e Ef S

[ ak, i [ Cancel

Set default pathe TS NBHL #&=Hs N2 8=E EFEFHN
HigetEAl O/ 2SS FRXE RaceTechnology EHE MESI! 0kE MEBEUH
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'Y Analysis - 8.5.330

File Data Results

ﬂi n Ij 0y

‘ﬁ % % Set language
Snap windows to arid {currently on)

show toolbar (currently shown)

set grid frequency
fove current window to layer
Close windows on layer

Close all windows

Input divisions

Enter new number of window divizions [2-50]

Ji
ra

e
b

R0

Set grid frequency= St HAR FS2 37 ZTF Higt gME B2 ETE

502 AT AAS MEET

'lUI-L|E|-_
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Analysis - 8.5.330
=}

Data  Hesults

Load logged data

Window Help

Akl &

Load data from database

Sdvanced load/zaves

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Advanced load/saves > Load default vehicle option2 AFTN2FEE

o, FUNY, FENT 5)

(3%, 18+, OE4, RPM

o,

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options

adve default venicle options

Load default sinulation options
Save default simmulation options

Load variable information
Save variable information

Load general options
Save general options

Load rmarkers/sectors
Save markers/sectors

Load screen layout
Save screen layout
Save current layout as default

Ty,

CHE M2 FE6H HMAI= ofF DAl 222 22 AnaylysisE MZE 788 F¥°l SASHH.
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' Analysis - 8.5.330
Window  Help

Eile Data Results

SRS

BB

Al &

Load vehicle option from disk
ZH= 2170 | 09 CarFiles
O -~
L =2 2EM
(£
HIEF £t
SMC
EHEH
: o 0IZm: | v| [ =20 |
WUHEHI B2 mao manT) |L‘¢'ehic|e data file {+ Car) v | [ & A ]
REEEEEEERG
o= SAR & IIYS 3 SCA 2°1'97 o ¥ diF IS AFZYO.
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Yehicle options

Fprn & wheel pickup | Wehicle constants | Power

b ounting Accelerumetersl Gearsl

Which of the units
faces will face the
front of the vehicle?

P
+ _monmsioe |
o

Important; when mounted with the left, right, front or back pointing fonsards the top
af the unit muzt point upwardz. *hen the top or bottom of the unit iz painting
forwards, then the front of the unit must point upwards.

Mate: this should not be
uzed with the dil mk3,
inztead zet the mounting in
the dl1 configuration
zoftware and leave this az
"back".

g

Front, iz the zide with the
mermory card zlob ot
Back iz the side with the
main connectars o it

E).
-
|
*

L Ol J Cancel

2
iz
1o
=
lo
Inu
rr

FOIN OKE MEfRiLT
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i Amalysis - 8.5.330
®IER Data
Load logged data

Results

Load data from database

Sdvanced load/zaves

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Window Help

G Ll

Advanced load/saves > Save default vehicle option2 HE
SO HEEACH OZ oM ME2

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options
mave default vehicle options

Load default sinulation options
Save default simmulation options

Load variable information
Save variable information

Load general options
Save general options

Load rmarkers/sectors
Save markers/sectors

Load screen layout
Save screen layout
Save current layout as default

foiM HE

= AR

OgoR MYSH

HE
=
L=

=L

o

N K}UFL' C},
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Analysis - 8.5.330
N [ata

Load logged data
Load data from database

Results

Sdvanced load/zaves 2

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Window Help

Akl &

Advanced load/saves > Load variable information

ool2e| MBS TFEUL,

(88 MpH Z2 Kph, 2HMNMZRE<9|

HE TS &5 BMAE o9 M&ACl MN2H2Z2 HEZ AnalysisE MZ

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options
mave default vehicle options

Load default sinulation options
Save default simmulation options

Load variable information

Save variable information

Load general options
Save general options

Load rmarkers/sectors
Save markers/sectors

Load screen layout
Save screen layout
Save current layout as default

2 U3 YHLANE AR Hste Hpdt
MRS Kg/cm2, 2TMMZHEQl MAZ MM SIM
1M FgOl
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Are you sure you wish to replace the current variable configuration with one fram file?

e

ME ¥ HOEE AN o MEED

T — =2 L-"1d
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' Analysis - 8.5.330

Eile Data Hesults Window Help

SRS BB Sk«

E

?)X]

v| [ =0 |
&ariahle configuration file §= Var) V|
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Analysis - 8.5.330
N [ata
Load logged data

Results

Load data from database

Sdvanced load/zaves

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Window Help

Akl &

Advanced load/saves > Save variable information2 HEE LAEATZE FEHE N
SO HEEQACHH CH2 T|3oMe AM&E Q8HM T O|§l= AN

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options
mave default vehicle options

Load default sinulation options
Save default simmulation options

Load variable information

Save variable information

Load general options
Save general options

Load rmarkers/sectors
Save markers/sectors

Load screen layout
Save screen layout
Save current layout as default

78?6

I8 Buyo,
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Advanced load/saves > Load screen layout2 A8AT AF =

i Amalysis - 8.5.330
Eile

Data  Hesults

Load logged data
Load data from database

Window Help

G Ll

Sdvanced load/zaves 2

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Save session to file
Losad session from file

Save logged data
Save logged data to database

Load default vehicle options
Save default vehicle options

Load default simnulation options
Save default simulation options

Load wariable information
Save variable information

Losd general options
Save general options

Load rmarkers/sectors
save markers/sectors

Load screen layout
Save screen layout
Save current layout as default

g9 BN 5 SIBMAPES BEEID
ofF o He N8
o2 Mg I MMAE oY T

Fe 1 FEL M YU o|Z°| o= TE BT,

NE4CE EHOZ Apalysiss

NE FSE ¥l

gtHel 3T YN 1 MES2 F

a4,



2. 27 - 20 SHHHAEE EasST

& Race Technology |Z||§||X|
OEEy MEE) EJGN SHFEINE ERAMI) SEH) aw
A iz |-
[ S Documents and SettingsWadministratordIE S8 Race Technalogy V| 0=
02 2 =6 39 ' [:] -._.-..
=3 WM A 20 BHED
= = = Setup 8,592 exe R EAINE Var SHHHY 2R Lay MEEEE Car

@ OIS 0 HA
e B0 28

JEH A

@ HHE st
i L=
q ZEH
SREECERE:

Hi2tMel RaceTechnology ZHIN °iT D22 0O/ SAR| 4G,



2. 27 - 21 SHHAYE

RACING SERVICE.KR
\

I Analysis v8.5.369

File Data

Results

SkS

Window Help

E &

B Ll

KE@ P E

Load analysis layout information

#= 23D | 9 LavoutFiles = = g
- = =HEE R
H &2 =M
£
HHE =1
FHC
= &H
, me iEme | v| BEE
HUESRZ E#3  mer saiT): Layout files (= Lay) v| & 4
5o A== 25
o= gAr] & DIHZ o9 Z09 29%7 o ¥ 3T oY Lo,
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Analysis - 8.5.330
=}

Load logged data

Load data from database

Sdvanced load/zaves

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

'3

Data  Hesults  Window Help

Akl &

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options
mave default vehicle options

Load default sinulation options
Save default simmulation options

Load variable information
Save variable information

Load general options
Save general options

Load rmarkers/sectors
Save markers/sectors

Load screen layout
Save screen layout
Save current layout as default

Advanced load/saves > Save current layout as default= ®M +&=H° A= Layout®l T2 o2
~Y5H OE MAZ RS MMAIE oiF Dol 24 E HE

2 & RAESE BFBYH. ° s

S
=

E AnaylysisE M=z #3%: IOl SASHC.
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Analysis - 8.5.330
N Data  Results  Window  Help

Load logged data

Load data from database > 8 M I.lﬂl. s

Sdvanced load/zaves 2

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options
mave default vehicle options

Load default sinulation options
Save default simmulation options

Load variable information
Save variable information

Load general options
Save general options

Load rmarkers/sectors
Save markers/sectors

Load screen layout
Save screen layout

mave current layout as default

Advanced load/saves > Save screen layout2 HEE SIDHHIAISH FH
S HPERACHH OF T8N AE2 261N OE CI182= MENTH

A B,
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ﬁ Run manager X
Mariable manager I gi ||DI

Laps and sector options
Edit default vehicle options
Edit default simulation options

Clear everything

Clear all frack markers
Clear selected data
Be-process all data

Analysis options

Mappingl Speedl GpsDatabase‘ D:uluursl Videu:ul Dbe filesl Dbc varsl Seriall

Always force analpsis to start in the following mode:

Start a blank 1, but with the default layout w

Wariables shown for selection in graphs et

(%) Manually activate variables

O Autamatically activate all wanables with data, commonly uzed derived
vanablez, and then first 5 user vanablez

Automatically update acceleration, distance, and mapping immediately after data is
Inaded [recommended for mozt applications)

] Automatically update all variables immediately after data is loaded [not normally
recarmmended)

|.ﬁ.utosave dizabled W |

Settings stored in;
C:ADocuments and Settingshall Users'Spplication DatatBace Technology 2 5hadminiztratort,

Ok Cancel

Data > Analysis options2 MEgLT,

ME ¥ HOEE A9 Data BN Ut LO| MHEP ¥ OkE MEEYT
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RACING SERVICE.KR
Analysis options
M apping Speedl Gpsl Datal D atabaze l I::::I::uursl "Jiu:leu:ul Dbc filesl Dbo varsl Serial l
b apping options
Jheck gpz data for speed/positional consistency
en calculating a map of the track uzing gps, don't combine the data wi
DWh lulat f the track dan't hine the data with
accelerometers. Thiz speeds up processing, but track maps are less smooth and precize
gt accelerometer data over gps data. To uge thiz option, it iz wery important that the
dccelerometers are zeroed comectly. See 'accelerometer options'
B emove stationary noisedwalk fram gps data
Y utomatically time align gps and accelerometer data, this recommended for all data accept
A2 and speedboy
ghare pre-processed speeds generated fram the hardware and force recalculation o
] I d d ted fram the hard df lulat f
gpeeds in analyzis [normally not uzed]
Ok [ Cancel ]

zO MHE JZE Fo|k FPSH FANY O|FE FYERT ZHEW EANEHA R Ol HE

of &L,

Mo X

Data > Analysis options2 {MEARLCE,
ME ¥ HO== B9 GPS HOIN 1o o MEISt ¥ QkE MEAZYC.

= =2 L-"1gd
(BISHEY 247 £822 A= ¢, T2 £8° TEH 272 )
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RACING SERVICE.KR
fnalysis options
: Speedl Epsl Datal D atabasze l I:l:ull:uursl "-.r"idenl Dbc filesl Dbc varsl Serial l
b apping optionz
Dheck gpz data for gpeed/pozitional consistency
hen calculating a map of the track using gpz, don't combine the data with
accelerometers. Thiz speeds up processing, but track maps are less smooth and precize
] Trust accelerometer data over gps data. To use thiz ophion, it iz ver important that the
accelerometers are zeroed correctly. See 'accelerameter optionz'
emu:n'-.fe statiohary noizedwalk from gpzs data
Automatically time align gps and accelerometer data, this recommended for all data accept
ar22 and zpeedbon
] |ghore pre-processed speeds generated from the hardware and force recalculation of
gpeeds in analysiz [normally not ueed]
Ok [ Cancel ]

zO MHE JZE Fo|k FPSH FANY O|FE FYERT ZHEW EANEHA R Ol HE

of &L,

Mo X

Data > Analysis options2 {MEARLCE,
ME ¥ HO== B9 GPS HOIN 1o o MEISt ¥ QkE MEAZYC.

(GIOIE2Y 2Nt 2822 HAEA B2 §9)
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& Bace Technology |:||§||z|
Or(Fy MEE) 2I0 SHEI|A BRI ESEH ?
Q- © 4 P ipm @

01 = CDocuments and SettingsadministratorwHIEr 219 Race Technalogy V| 0=

N e B

Setup 8.5 0% exe R EADNE Var SHHHH R M Lay FEEEE Car

0 2 =0 =Y
£9 DI7IN M =0 2rS0)
QD OS2 HA

b2 200 2R

JIEH 91X II:.J
@ bi= B

@ [ =

3 ZEH

& W UES3 22

RT150409

DL1 & GICIHZMe M=o MP=C] AE HI°H EHE SA% ¥ 3ot RaceTechnology EH

o E°8T EHC.



GRS

Data

(I Analysis - 8.5.330
File

Besults  Window Help

RACING SERVICE.KR
\

Load a run from disk
2= 217 | 3 Race Technolagy v @@
L 37 EE Earaka i F A
o 204 2NEs-d-10 2=
Ll =2 =M
[£
HHEF 1A
@
=MC
HEH < m 3
: OH OIEN: v| 270 |
lHUESI 22 qor sy |Hun data files (= run 3 v| e
(a2 #e22 221

9 HM AY BNE o028

g EH7 EAEYN.

SO BgolH2| RaceTechnology EH=Z EI2EHM 29937 o FR4
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{2 Analysis - 8.5.330

File Data Results

GRS

Window Help

El-WANE

Load a run from disk
v @& E
3 BB S EEE S
1OKE  RUM DR ME-Nd-9 2= ..,
EMC
ZEH
THe 012N | v | BEE
lHUESI 2 qorsany Eun data files (= run J v | [ & A ]
REEREEEESG
20147 o SIH BHES MESl AYE Lo ENHD MO ¥ FTE MepC
WY RUN T2 38 QA 4 QIDR MR s ol M2 O|SeE NFW Sk HO 3
g4yo.



3 AlSH _ 4 A= A9 AA
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Load video file
Do you want ta load a video from a GoPro to go with in
FTEHEHE now?

|§Flease don't agk me thiz agaire
N7E oD gamnel 5XE QSN GoPro AXZ AN MAE JATAL SH pFT A2
A BFSt= HHOIH ArgAN Mo Lo mMEtM MEISHH ELC)




3. MY - 5 CSV EMO=E Export

RACING SERVICE.KR
\

Ei

Analysis — 8.5.330
=]

Data  Besults  Window Help

Load logged data 8 M 2
Load dats from database 1 ||DI

&dvanced load/saves r

Set serial port
Download data

Export as data, ., ) Data export manager

Export as video,,, .
P E=part ta file type

?!n: setun . (&) & preadshest Csv file, using delimiter;, |-
Erint,,,

Frint all,., () Matlab M file

set default paths
Farrnat flash card
Feset to factory settings
Change swap file

() Matlab b at file

[ata range ko export

Exit i
I Sample period of exported data: HEI.EI'I |

Fun to expart fram: |_7.3$.=H HAY W |
E wpart data from |IC| To
E xport entire run ] Export highlighted section
[ 1] ] [ Caticel

o] e A csvE export S1E™ FILE > Export as dataE {MEiStH FUC

o
T H2EE B°M= export ZU B, export MUY B, export HABZNMIE) 52 2
=}
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4. 28 - 1 Lap and sector times 1

RACING SERVICE.KR
\

F& Analysis v8.5.369, 46_Q

File Data Hesults Window Help

SLES BB A&

Best Hiz
Thearatical, 14:04.73 {i} 14:04.73
Continuous, 14:04.73 {:} 14:04.73
Lap times

Run "96_0" [14:04.79)
||Lap 1140479 F (|

Tool bar®l HMo= HAIE o[22 MHSIH FEHC A& FIIE WA F 7Y ANl 1 mAQ|
O|E° {2t &° HEE [Lap and sector times] ¥OINM EAEHH.

O FoIM MEEOl Re T Y fMOIH fe Lo MA2 °|F2 MESIH 3T FHI} EANFHH.



4. 28 - 2 Lap and sector times 2

RACING SERVICE.KR
\

b& Analysis v8.5.369, 46_Q

File Data HResults Window Help

& @E@Mlﬂl

@

X
pes
Theoretical, 14:04.73 @} 14:04.73

Continuous, 14:04.73 {:} 14:04.73

Lap times

Run "46_0" [14:04.79]

Lap 1. 14:04.79F ()

Race Technology MAB2 GPS [Pt FHO|E2 HTO| Beacon® E2A ZFEYL M= FAIFPHE

52 BS 9 NN NUENE 3

N LAP M2 3o UYL

FJANMOl 1 Lap2=E HAIEEZ 0f Lap2 time2 EASH] 2I°0
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- 3 Lap and sector times 3

RACING SERVICE.KR
\

né

VA
Fi

Analysis - 8.5.330
N [ata

Load logged data
Load data from database

Results

Sdvanced load/zaves

Set serial port
Download data

Export as data..,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Farmat flash card
Reset to factory settings
Change swap file

Exit

Window Help

Akl &

Save session to file
Load session from file

Save logged data
Save logged data to database

Load default vehicle options
Save default vehicle options

Load default simulation options
Save default simulation options

Load variable information
Save variable information

Load general options
Save general options

Load markers/sectors

Save MAMKers,; Seciors

Load screen layout
Save screen layout
Save current lavout as default

Advanced load/saves > Load marker/sectorse Lap timeZ

4.

TA

4L



4, 2M - Lap and sector times 4

RACING SERVICE.KR
& Bace Technology |:||§||z|
OF(py  ME(EY S0 SAFNE) I T3EH) ;#
Q= © B3 P @
F(0) |55 CtDocuments and SetfingsWadministratorHIES S8 Race Technology V| =
JIEF A NOORGEME TEF: AMS AN, LAP IMJE, LaP IMJES, LAP
A5l
SOMGDO, LAP TAEBAEK. LAP YOMGIM, LAP YOUMNGAM, LAP

Hi2tMel RaceTechnology ZHIN °iT D22 0O/ SAR| 4G,



4. 2M - 5 Lap and sector times 5

RACING SERVICE.KR
\

| Analysis v8.5.369
File Data FHesults Window  Help

=MC
HEH
: OHY DIZ(M: v| R
HUHESI B2 mosam Track marker files (= Lap } ‘V| & 4

HEEREE= =)

ot
=
rot
ot
ko
Y
I
rir
H
e
o
4
o
ngt

02 SAR) & D22 ofF 269 29 4o



4, 2M - 6 Lap and sector times 6

RACING SERVICE.KR
]

F& Analysis vB.5.369, 46_0Q

File Data Results Window Help

SkS BB Ol

(=7 &

Best Sector 1 Sector 2 Sector 3 Sector 4 Sector 5
Theoretical, 2:15.58 {E} 4311 25.22 25.65 20.37 21.23
Continuous, 2:15.64 O 4317 25.22 25.65 20.37 21.23
Lap time= Sector 1 Sector 2 Sector 3 Sector 4 Sector 3

Fun "46_Q" [14:04,79]

Lap 1. Mfa Mz M= 28.90 21.43

Lap 2, 2:15.87 {:} 43 11 F 2529 25 54 20, 21.23 F[:I
Lap 3. 2:15.67 F {:} I 4317 C 0 23.22 FC 2363 FC| 2037 F 21.28
Lap &, 2:21.83 {:} 45.09 26.14 2615 21.27 21.60
Lap 3, 2:17.32 {:} 43.79 29.30 2636 20.74 21.73
TR T TR ran AR ALk ]

2HIE Lap T&A°| AEEM O Lap® timedt H5I9M A= W Sector? time®l EAIEHH.

It Lapdt U Sector? HW NFE2 F/2 SM=E EEYGH.

Sector time WS O[S C2td EAE H2 HS ©I9M Best lap®l EYERS WE EINBHH.
pO

(HEE 2fOIRE WASN 1 Lap©| ZAE

= KOl ofd, Tt AHWINEE 2¥E W - OE AY)



o
MO
12

7/ Track map
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S Analysis - 8.5.330 /Bun: =3 Hy
File Data Results Window Help

S22 68

K E @

[ Track map |
Data Options @ @ a ™o ap % @ i ﬂ nteractive mode

Scale: S00m

F: =%y H completfrun

Tool bar?l HMOZ HEAIE O0|22 MESIH AFEHO A= FY2 MH F= A 20| HREE
[Track map] g°IM EANEYC

Interactive modeS (ME{SHH MEAEO] QA= DA gt F= FET ¢ &0 FAEHH.



4. 28 - 8 Track map

RACING SERVICE.KR
\

NS Analysis — 8.5.330 /Bun: =3 =Y

File Data Results Window Help

<23 O QKW *EEKEN ;

Data E*] _
Gios Drigplay
[ | Map colour bazed on time [z] hd | [ Min D M
F: =% H, com [ Display g force vectors [ ] Offset individual maps
[ ]FReverse g force vectors
Map owverlay Track map statiztics
[ bownload map a3 background [ ] Show statistics on track map
[ 5how titles with values
[ Sectar ||:| b arker
Click to add Click to add
Click to add Click to add
Click to add Click to add
Click to add Click to add
Ll i |

[Track map] &9 = YH option2 MESHH 9t 2O HREE BN 7 4

x
MYS BFSE BMARAETL YFOE NE T Y ANO| UEYEE TR 4 gy
QIEY 10| SO RIO{OIB YN CHREET o0 Allo| 18 WIE 238U



4. 84 - 9 XY graph

RACING SERVICE.KR

r Analysis - 8.5.330 /Bun: =#HAH

File Data Results Window Help

SRS R & M:: Lﬂh Gy P

O ptions ]@ %:1 @ Qe E @ = i u [ ] |rteractive mode

F: %3 H, complete run

210,

1a0.

on
=

2
[}

[4dy] pasds

o
(==

E.

a0,

0.0

Qnﬂ.u Z200. A0, B0 . g200. 11000, 13200, 15400, 17600, 15300, Z2000,

distance [m] a

Tool bardl HMOZ EFAIE ofo|22 {MEISIH RFEO A= MUY SFHTNA] FEI} 9 o HeE2E
[XY graph] 7&°IM EANEYD.
Interactive modeE ME{SIM [Lap and sector times] &°IM MEALO] A= DA CHdt o FET}

et ol EAFYH.
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4, - 10 XY graph

RACING SERVICE.KR

r Analysis - 8.5.330 /Bun: =#HAH

File Data Results Window Help

SHS g 4

Options ]@baaﬂlﬁ E @ Ptﬁ"ﬁ'??"??"ﬂ

210,

1a0.

on
=

2
[}

[4dy] pasds

o
(==

E.

a0,

0.0

[ ] Interactive mode
F: %3 H, complete run

=30

(k7] Z200. 11000, 13200,

distance [m]

A0, B0 . g200.

15400,

17600, 15300, Z2000,

[XY graph] & ¥H2 ©°I252 MESHN
N

BESH, =79, gH, Z2, oA °lF, X5 TSR, Y5 A=A

@ B @ @ w4 §



4. M - 11 XY graph

RACING SERVICE.KR

NS Analysis - 8.5.330 /Bun: =AY
File Data Results Window Help

S22 BB Sl KE @D

.

i awiz configuration late run
tultiple o [ ] Manual limits E [ ] Manual limits
anable name fanabie’ name

| speed [kph] w | | distance [m] w |

|:||time [2] V| |time [2] V|

|:||time [2] V| |time [2] V|

|:||time [2] V| |time [2] V|

|:||time [2] V| |time [2] V|

Start axiz from zero
Llze data from [rata dizplay options
W
[ Multple plots Set by lapz/sectors .
Run Lap S ector Fattredian | P Hlahet 2ot
|_’F_ff_=H?§.'“_='._ v| |N|:|Ia|:|s defi v| |Whu:u|e lap v| ast tectaw ghest acCuracy
Dizplay track markers
Jain graph points
[ Reszet ming and maxs —
|
% ZzO0. 4400, BELD. BE00. 11000, 12200, 15400, 17600, 19800, 22000,
distance [m]

Gl i
[XY graph] & Z& ¥He| option2 MEHSHH
SN BEATE 8 MESe FF X 1 WeE YFROIM MEZ £ AN
NIt Z2 HE %R O MA 5 RS FOE T NYIE XZIN MEZ & syt
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RACING SERVICE.KR
\

Tool bar®l HMOZ ENE Olo|2g MEE IFEHO| Ui

r¢ Analysis - 8.5.330 /Bun: =3 A

File Data

HResults

S22 B8 Kl d

Window Help

kK

Options
[ ] time [s]
long aceel [7]
|:| lat accel [g]
|:| wactar accel [g]
[ | RPk [pm]
spead [kph]
| ] distance [m]
| ] position x [m]
| ] position ' [m]
[ ] time slip [=]
|:| time slip rate [%]
|:| corner radius [m]

83571~

TOLT

,0g-

lang aceel [g].

i

11

—== |

speed [kphl.

b

M 89 & _complete ran

[Quick XY graph] &M EAIEYMH.

¥ 59 A

Lt

HAI

o1

=2 00 =X
of FoIN ITE EASH AN

022 ZF A + shirt 31 + 02

ot
=

Al tickoiM

Nt | gy @

XY graph g EAIE

=L

MEH

[y |

ool oA FH f12 &° HEE=

& gy
U J2moy

= FA° oM Quick XY graph d°l EANEY



4. 24 - 13 Quick XY graph

RACING SERVICE.KR

fG Analysis - 8.5.330 /Run: TH#HAE Y

File [Data Results Window Help

SRS BB Lkl & g & @ >

E, [Cuick graph]

Group graphs by wariable
[ ]Plat against time [not distance]

n ] !'nin and max iz zet in vanable manager, use
thiz for graph scale
Dizplay all v axiz scales
[ ] Black background
Show values
() Do not show values
() Show values at pointer
(%) Show values at top of graph
) Show values in table

o . Mo data available
Ilze interactive selectar

[Quick XY graph] & 3% 4Hel optiong MEfetE
AE B2 M@ BEAZ KO AJH B2 HEZ XZ IE ME S Teo| MM B A MEL o 4

matHo,



4. 2M - 14 Bar Chart

RACING SERVICE.KR

IS Analysis - 8.5.330 /Bun: =#E
File Data Results Window Help

SRS B8 4K KE @

Options | [Jinteractive mods %X

R: =93 H_complete run

w CeImoomTT
£
oo
T
|
]

24z

0.04= ' | I_l

552 174 292 411 5248 EB48 TeEE 885 1000 1120 124 1380 148, 1600 171, 1830 185, 207, 2180 231, 243
speed [kph]

Tool barl M2 EAE Olo|2g MESIH IFEO| Y= TSl oA FE Yt To| HeEE
[Bar chart] %°IM EAELIC,

of FoIN ITE EAST YOIME XY graph Fol ENEO U ITYA

QA BF | + shirt 3 + 09A SAT%E MEEE ¥l O8N Quick XY graph ¥l ENEY

Lt
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4. 15 Bar Chart
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RACING SERVICE.KR

S Analysis - 8.5.330 /Bun:

FHAD

File Data Results Window Help

SRS B8 4K

KE @

P

[+] Show grid [ ] Display as a curnulative distribution R: 934, complete run
Show barz Show rezultz az a percentage
Sho [i
Al Mumber of interyals
irirnum b amirnurn
“Wariable to displaylgpeed [kph] v| |:|| | |:||
[ Only count i time [5] v| 10000 | [tooo0 | —
171, 183, 195, 207, 219, 231, 243,
qu
[Bar chart] & & ¥t option% MESSHH
ol ME AHY S UYL o= MEZ g 2 AL
4 Y08 LFs £N9 HYE BFY £ ACH
Off ME2 EAZ HQIf, O HAA / HOjAIL| £F, 2T FA |E 2 BFY & A&HD



4. 2M - 16 Performance calculation

RACING SERVICE.KR
]

(S Amalysis — 8.5.330 /Bun:|ADE=t=2

File Data Results Window Help

SRS OB Sk Ll|d ™2 5K E @ P EP s

erformance calculations ﬁ

Braking ztatz | Custom table 2 | Custam table 1 | Power

Setup and options  Speed ws time table | Speed vs distance table | Distance ws time table

Start zpeed
End speed 40kph|  SOkph| GOKph| 70kph| Bokgh| 0kph| 100kph| t1okph| 120kph| 130kph| tdoKpR| -l
A0kph 070z == Mia Mia Mia Mia Mia Mia Mia Mia Mia
G0kph 1.59: 080z == MHia Mia Mia MHia Mia M ia Mia Mia
70kph 292z 222z 1.33 == Mia Mia Mda Mia Mia Mia Mia
8kph| 407s 3375 2485  115s == Nia  N/a N/ Nla  MNla  Nia
9Okph| 5295 4595 3635 237s 1.2 == N/a  N/a  N/a  N/a  N/a
100kph| 685 615 525 393 278 1.56: = N/a  Na N/a  N/a
Mokph| ©37s 788 6785 5455 4305 309 153 == Nia  M/a  N/a
120kph| 10.20s  950s  861s 7285 613 4915 33/s  1.83 = Nia  Nia
130kph| 12455 1175 1085s 9525 8375 718s  560s 4073 2245 == N/a _
140kph| 1526s  1456s 13675 1234s 11195 997 G41s  68% 506 2825 ==
150kph| 17.95s 17.25 16.35s 1503s 1388s 1268s 1110s  957s  7.75  550s 269 == =
Kl _ LIJ
Il

Tool bar?l HMO=Z HAE o0|22 MHSIH AFHO A= T2 A=A FEI % &0 HeEE
[Performance calculation] B°IM EAIED 5 & S° ZE 24 Higt EAY| HEgYH.

Of oM IHES EASH fPIME XY graph o EANEC Re 2HEANM

022 BZF 3| + shirt J + Off2 E300tH MEEE= 9 M Quick XY graph &l EANEY
.

12



4. 28 - 17 Performance calculation EFEasT
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(S Analysis — 8.5.330 /Bun:|ADE=I=2
File Data Hesults Window Help

SRS B8 Akl

Paver

ENCICIE A

Custom table 2 | Custom table 1

Braking statz

Diztance ws time table

Setup and options | Speed ws time table | Speed vs distance table

Criteria uzed for start and end

Trigger acceleration for test [a]
"Zem'' speed threshold [kph]

These figures are used to determine where the start and end of the run are. If you want to force the tables to
start calculations from the start of the selected area, then enter O far the "trigger acceleration and a high

nurmber for the "zern speed threzhold"

T able intervals

Speed interval on tables kph]
Distance interval on tables [m]

Data currently zelected and uzed in tables

Run: |

Selection start time: I:I
Selection end time: I:I

[Performance calculation] & 4Tt Setup and option®IMe HMUE EASY Y¥e £

N\
IHY & Uon

S - NIt AE - H3, HE - AR 5 NS PHOE BME HFON 2 & UsUD



4. 28 - 18 Summary statistics

RACING SERVICE.KR
]

F& Analysis v8.5.413, [11, A=3F}L_

5 ==

File Data HResults Window Help

ﬁ%@ﬂ&@%ﬂ@“ﬁ

KE @D

Surnmary statistics |
| Complete lapsz W | m
Auerage |Worst, | Best theoretical, | 2= | =3k | 2= ‘ >

2:10 3ATAZ |B:35.45 | 2:10.00 Lap2,2:11.5% [Lap 3, 2:11.10 |Lep 4, 6:35.45 |[E9
bdzrimum of long accel [q] 0.70308 07375 0.7013 0.757494 0.757494 0.73568 07013 07030
bdimirmum of lang accel [g] 15161 14838 -1.3902 -1.5161 -1.5621 -1.46E5 -1.34902 -1.3161
bdzaximum of lat accel [g] 18329 1.7363  1.6402 1.83239 1.7322 1.7224 16402 183219
bdinirmum of lat accel [g] -1.8988 18372 -1.7835 -1.8951 -1.2951 -1.791%8 -1.7635 -1.2988
kdzamimum of RPh [rpm] EEJ3.E EBEEI.4 EBE3I33 EE33E EEJ3E ETE1.1 EE33.3 EE33.E
kdaximum of zpeed [kph] 25652 25185 2516 251.43 247 8 251.43 25165 296 .52
Time positive tps [ 120008 1BE.45 293 .43 120.78 124.1 123.21 298 .43 120.0%
kdasimum of ailt ] TE.43E 90.0T7H 163, TE 436 533 E7.578 163, TE .36
bdzgimum of water [] 0178 104 153. a0.178 83823 89045 153, 40178

I=a

Tool bar®l HMO=2 EAFE ©f°|22 MHSH REEA Re T2 3NA

NE TEI} 92t o HeE2
[Summary statistics] SN EAIFYCL

=
[

of Fol OfFTHA AEe| FHE AMNS| BHO| WAN oA YNOZ EAT & UG,
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RACING SERVICE.KR
]

Complete laps

Lz = [fforst, |EBestthearstical, | =3 ME, | 2534 JE, (2F3_NE,

Complete laps A:35.45 | 2:10.00 Lap 2, 2:11.58 |Lap 3. 2:11.10 | Lep 4, 6:35.45

Sector 1 7013 075754 075754 0.78563 070132 070508

Sectar 2 2902 -1.5161 -1.5621 -1 .48E5 -1.3902 -1.5161

Sectar 3 402 1.8329 1.7522 1.7224 16402 1.8329

Sector 4 JE35 -1.2951 -1.2951 -1.79128 -1.7625 -1.292E

Sector 5 BE2T.2 BE33E BE33 .6 BTE1.1 EE33.3 BE33 6
| Sector B 5] 65 251.43 247 8 251.43 25165 256 52

Time positive tpz [] 12008 1EE45 29243 120,76 1241 12221 298 .43 120,02

bfasimum of oilt [] TEA3E| 90078 163, 6 436 53.3 67575 163 TE 436

hdztimum of water [ a0.172| 10401 153, an.173 83823 29,046 153 a0.173

[Summary statistics] SN EAIEH= HAUE B & £
GIE S0, MEE FAo| CHIHM EAIBICHLL, [A| BS2 HAD

Sector 22 HA[SI= FB S° REHH.

HHY, FFE=AN HHON R
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- 20 Summary statistics

Change in

‘Change in
Y ariabl§| Average of
b awirnurn of
kdinirum of
Std devw of
Cov of

93% max of
95% max of

Title to dizgl

I

Add new summary statistic :

RACING SERVICE.KR
]

Delete meazurement ] [ k. l [ Cancel ]
Complete laps - |
W Awerage | YWorst, | Besttheoretical, | 2=Z3f 23 btk
712 | 63545 (2:10.00 Lap 2, 2:11.58 [Lap 3. 2:11.10 | Lap 4. 63545 (&

bdznimum of long accel [g] 0.70m08 07375 07013 0.75794 0.73794 078568 0.7013 070508

hdimirmum of lang accel [g] -1.51610 -1.4838 -1.2902 -1.5161 -1.5621 -1.4EES -1.24902 -1.5181

hdzmimum of lat accel [g] 18323 1.7363 16402 1.8329 1.7322 1.7224 1.6402 18323

hdinirmum of |at accel [q] -1.3986 -1.8372 17635 -1.8951 -1.8951 17918 -1 7635 -1 3986

bdauimum of R Ph [rpm] EE33 6  BEES .4 EBE333 EE33 6 EE33 6 ETETA EE33.3 EEI3E

bdanimum of speed [kph) ZOBSE 25185 23165 Za1.43 247 .8 2a1.43 23163 Zak .52

Time positive tps [] 12008 16645 293.43 120.76 1241 123.21 298.43 120.08

hdzamimum of ailt [J TE43E 20.073 163, TE 436 333 ET o573 163, TE 438

bdzsimum of water [] a7 10401 193, a0.178 93.823 99.046 133, anaTe

74
[=d "
Toti o ol - =23 re) o] O HiEH II I (o]
[Summary statistics] &< HO|RE 2 HESY o M=2 FHL2YS oHdt FHo= HEAZ AQ
HASI= L}
Al BF%E= 3Ol HEEU.
=~ =l X P AN = = o I A Ol o = ol

g SM Hotg, B, HJIA, HAA F OHINA NEL=E BEANZ £ ULE OYoH MEIO] ZFH|EO R
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Add new summary statistic

h-1|:u:|e| b airniuimn of v |

Yariable| speed [lph] il
M -

Title to dizpl| distance [m] )
pozition ¥ [m]

fion"” [m] 3
e sp[5] | |

time =lip rate [%]

[ Delete measuren) ime inta lap [s]
tirne inko sector [2] w

ModelM [Maximum of] & &8t Variable®l™ [Speed]E MEASIH MEISH FAYM HIKEE

B 3 EANZ & AU

Add new summary statistic

|"-"|'2"2|E| Integrated square of w |

Yariable| vector accel [g] i

Title to dizpll P [rpm] n

zpeed [kph]

wheel zpeed [mph] L=

diztarice [m] :I

gear [-]

[ Delete measuren] positian & m] j
pogition v [m] il

Mode®lM [Integrated square of] & MESID Variable®l™ [Vector accel]l2 {ME{SIH ME{S FNH9
(o]

=
Mo ArgEl Vector Accel? 3 Bi¥Z 2 £ ASH.
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i Analysis - 8.5.330
File Data Results  Window Help

Load a run from disk
= AT | RTIE409 v O @
g - 37 &= SHot Eh
1M0KE  RUMN IFX Me-14-M 2=
H =2 =M SEiAE 2 RUN 1M0KE  RUMN IFX 2Me-04-M3 2=,
— “ai-EH e 3 RUN 1M0KE  RUM IR 2Ne-04-M9 2=,
£
HiEr =4
EMC
ZRH
IHE 0| 2iM): |"—’F—f’="§E_1.HLIN" "EEIEE P RUNT FEEE S v| 0]
WUEHI &2 moy seiiTy: |Hun data files {=run ) V| | A
L1832 #e22 SR

OeAZ CAT8M o3 Tjef D2 A 182 & REUC.
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% Analysis - 8.5.330

File BEEEN Besults  Window  Help
ﬁ Fun rmanager

Mariable manager

Analysis options

Laps and sector options

Edit default vehicle options
Edit default sirnulation options

K E @ >

Clear everything
Clear all track markers
Clear selected data
Be-process all data

\?/ This will clear all raw and processed run data, do vou wish to continue?

I IEETE

Data > Clear everythingZ MESHM FETO A= TA2 HLZ & ASHC.
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Best Sector 1 | Sector 2 Sector 3 | Sector 4 Sector 5 Sector B Sector 7 Sector 8 Sector 3
Theoretical, 1:59.81 (= 8.7 1412 & 54 2r 18 1462 12 89 1033 12 B4 16.17
Continuous, 2:01 16 ) &E0 14.54 &3 2r a3 1462 12 86 1037 1270 16.35
F
Lap times }— Sector 1 | Sector 2 Sector 3 | Sector 4 Sector 5 Sector B Sector ¥ Sector & Sector 9
Run ™EC 1B _R_:
51:57.72) Reduce run length
Lap 1,2:51.49 Set ambient conditions 0.38 3618 16.73 17.11 15.47 172 2147
Lap 2, 2:13.12 Change the run name 0.1% 2414 15.99 1352 10.99 1311 1680
Lap 2, 2:04.83 e —— 871 2273 16 51 132.27 10.47 1281 16 44
Lap 4, 2:01 46 c | d dat 873 2304 14.71 1293 1033 F 1278 16.40
Lap 5. 2:01_27 | ave logged run data 4 F 2xa0 1462 FC, 12860 103700 12700 163SC
Lap &, 205 &7 Save data to database A G| 22330 1533 1289 F 10.71 15 54 17 12
Lap 7.2:22 &0 Reprocess run 8.7 23178 1562 1328 1.76 1609 2903
Lap 2, 2:58.16 = THEY 7 8.3 2754 19.02 2926 12.70 2158 19.11
Lap 9, 2:05.75 & 8.45 15.07 8.05 2318 15.40 13.00 1042 1313 1654
Lap 10, 2:01.75 & &3 14.54 & B 2234 1518 13.08 1061 1273 1617 F
| = = = AN AN
8 B EA B MM ALY BAE RAINM 0L $F AE S5 MEEHOE MY £ ASHH.




5. 8 - 3 MEIAN A3t 1

RACING SERVICE.KR
\

Y Analysis - 8.5.330 /Bun: =3 H Y

Eie Data Results Window Help
@RS BB Akl & =5 IKE @
Quick graph

- x
D time [s]

D lorg =ccel fig]

| ] lat sccel [a]

| ] wector acesl [4]

| | wertaccel [a]

| | speed [kph]

| | distance [m]

D power output ]
[ ] gear

D position X [m]

| ] pesition ¥ [m]

| ] time slip []

| | time slip rate [%]
[ ] buffer H

l:‘ analog 1 [w]

D analog 2 [

D analog 3 [W]

| ] =nzleg4[v]

| ] =nzleqs [v]

| | =nalog & [v]

| | =naloa 7 [v]

| | analog s [v]

| | GP%altitude [m]
| | GP%heading [degs]
| | GP%time [5]

D GPS pos ace [ Mo datz 3vailable
| ] GPSwelace [

| | GPShead ace [

| | GPsaltacs [

| | GPSwelraw [mph]
| | GP%long [degs]

| | GP%lat [degs]

D User wariable 1 [-]
| ] Uservariable 2 []

| ] Userwariable 3 [

| | Userwariable 4 [
| | Userwariable 5 [4

| | 5l speed [mph]

| | 5 time slip 5]

| | 5t time slip rate [%]

LG i

><
<
[
L
IH
Jot
rlo

Quick XY 23Z && A HAIEHE AE0 2% Zo| 2ROY2E Fop =Hp F2

4o,

>

21
et
o

-
30
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= 27 6 K (& @ [

ﬁ Run manager X
Mariable manager I gi ||DI

Laps and sector options
Edit default vehicle options
Edit default simulation options

Clear everything

Clear all frack markers
Clear selected data
Be-process all data

Analysis options

Always force analpsis to start in the following mode:

Ei tart & blank on, but with the default |ayout w |

Wariables shown for selection in graphs et

anuall_l,I activate variables

vanablez, and then first 5 user vanablez

Inaded [recommended for mozt applications)

recarmmended)

|.ﬁ.utosave dizabled W |

Settings stored in;

O Autamatically activate all wanables with data, commonly uzed derived

Mappingl Speedl GpsDatabase‘ D:uluursl Videu:ul Dbe filesl Dbc varsl Seriall

Automatically update acceleration, distance, and mapping immediately after data is

] Automatically update all variables immediately after data is loaded [not normally

C:ADocuments and Settingshall Users'Spplication DatatBace Technology 2 5hadminiztratort,

Ok Cancel

Data > Analysis options2 MEgLT,

ME ¥ Ho2: el Data BOIM 9%t ZO| MEt ¥ Ok
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(& Analysis - 8.5.330 /Bun: =8 =5

Data Results  MWindow Help

%%@E&@%M@“EWMWJ

Options
[ ] time [5]
| | longaccel [4]
|| lataccel [q]
D wector accel g]
|| RPM [rpm]
D speed [kph]
D distance [m]
D position X [m]
| ] position ¥ [m]
| ] time slip [2]
| ] time slip rate [¥]
| ] corner radius [m)

Mo data zvailable

Variable manager®l ZYe=9 Re M22C] ZAAH FUHC.
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P& Analysis - 8.5.330 /Bun: =38y

File Data Hesults MWindow Help

G2 BB

“Yariable manager
Options ﬁ

=-[& Standard variables

s long accel [Longitudinal acceleration]
[ brake flag [fcceleration flag)
lat accel [Lateral acceleration)
vector accel [Wector acceleration)
[ wert accel Mertical acceleration)
gpeed [Combined GPS and accel]
wheel speed [Speed from wheels)
distance [Distance traveled)
power output [Power at the wheels)
torque output [T orgque at the wheels)
gear [Curent Gear)
poszition = [ Poszition)
posiion ' [v Poszition ]
EA time slip (Time =lip)
ime glip rate [Rate of time =lip]
heading [Current heading]
change in heading [Rate of change in heading)
carner radivz [Current comer radius]
lean angle (Estimated bicycle angle]
time from lap [Time from start of lap]
[ time from sectar [Time From start of sectaor)
[ waw rate ['aw rate from gyra)
[ vaw [Processed paw)
@pitch rate [Pitch rate from gyro)

pitch  [Processed pitch)
[ rall rate [Rall rate from gyra)
[ rall [Processed roll)
O &lip angle [bodw slip angle)
[ buffer [size of the memaorny buffer)
[ ¥idea frame [Widea frame)
[ ¥ideo CPU [Video spsterm CPU load)
[ “ideo bulf [Video system free buffes)
[ video chapt [Chapter markers that have been added to the video file)
External inputs
Simulated variables
Gps vanables
+-& User defined variables
ML Serial variables
4L CAN wanables

Eal o

@HDDHHHHDDDHD

o T e O O O OB =B O O =B - O - 0 s - < s £ A==~

- -

Data > variable managerg ME{gL L,
ME ¥ o= BO HOAI= U MESS HF tick oM ZYshHEYS & £ ASHD
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% Analysis - 8.5.330

File BEEEN FResults  Window Help
é Run manager

Mariable manager
&nalysis options
Laps and sector ontinns

KE @

il Analysis options

Edit ¢ Mappingl Speedl Gpsl Datal D atabaze Videu:ul Db filesl Db varsl Seriall
Clear
Clear
Clear
Re-p

calour 1

Click ta zet colour 2

colour 4

Click ta zet colour &

I

12 H(B):
T 0 T
5 T ..
N N N NN ..
------- [ Ok H_ Caricel
MER FIE A(C):
T 5 .-
BN N N N N .
| ASRIAE M OEIND) > |
1E3IIEES

Data > Analysis option MEB ¥ HQEr= A9 Colors B2 MESHM 1HT MAS HE 2 ASHCL
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¢ Analysis v8.5.403, [Generall

Eile Data Results BUAGGEES Help

ﬁ % E% Set language
=et grid frequency I. k

% (=]

Window > Edit layer name2 {ME%M Layerd °[E2 HIE £ USHH.

[ Data ][ Optic Close Wind::'wg on layer % E [P "D % q.; % [ Interactive mode
| Goale: 0.02m Close all windows

Edit layer names Layer 1 (Layer 1)

R: . complate run v General Layer 2 (Layer )
Sirmulation Laver 3 (Layer 3
Comparative Layer d (Layer d)
Grip and Power Layerb (Layer &)
Vides Layer B (Layer B}
Standing start Layer 7' (Layer 1)
. Layer 8 (Layer 8)
q Layer 9 (Layer 3
g Layer 10 (Layer 10}
0 {Layer 113
" Layer 12 (Layer 127
12 Layer 13 (Layer 13}
3 Layer 14 (Layer 14)
14 Laver 15 (Layer 15)
- Layer 16 (Layer 16
G Layer 17 (Layer 17}
17 Layer 18 (Layer 18)
18 Laver 19 (Layer 19)
un manager Layer 20 (Layer 20

b Units
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New name
Fleaze enter the new name EH|
=P
[FAST Racing |

Window > Edit layer name2 {ME%M Layerd °[E2 HIE £ USHH.
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¢ Analysis v8.5.403, [Generall

File Data Results BLGEES Help

et language ‘:‘HE
‘ﬁ % @ Set grid frequency l_ A E

e A 9 RE [interactive mode

[ Data “ Hpid Close winn:l::uws an layer F %
| Soale: 0.02m Close all windows
Edit layer names L
F: . complete run
v General
simulation

Comparative
Grip and Power
Yideo

standing start

Mo data awvailable

FAST Racing
12

13

14

15

16

17

18

ran manager
b Units

Window > Edit layer name2 {ME%M Layerd °[E2 HIE £ USHH.
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Cursor right: H1.01=

Cursor left: 0.01=

Cursor up: +=

Cursor doven: -1=

Hald =hift in increase by s10

Tab right: mowe forward 3 sectordap
Tab left: mowe backward a sectorap

Fage up: mowe bo nest laper
FPage dowen: mowe o prewvious aper

D key -load data from the data base

Ezcape key - clear the current data selection
kA key -add a marker at the current point

£ key -reset the 2o0m

TN SHANME f9 FHE RS

CAEE
CAEE
e

- A{EH K]
-|__|

= X|EollM 0.01xF ™
= X|EollM 0.01xF =2
= X HolM 1= [z

= XA 1% £
=

Tab +<— : O™ MEf 22 3o
otel 22 Shift + Tab + +— =2 —»
Pageup :ClS LayerZ 0l

Page down : O|™ LayerZ O|=

ESC:

SN °H 52

cHlolE Ho|AZFE HOIH 75
A MBI E O[] clear
: MEdE X|Hofl Marker F7t

: zoom 2|A

NS AU 4 ABUT
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F¢ Analysis v8.5.403,

®IEN Data  Results  Window  Help

Load logged data £ M Ilﬂl_
Load data from database b

Sdvanced load/saves k

Export as data, .,
Export as widen,,,

Print setup

Print, ..

Print all, .,

Set default paths ) ) )

Farmat flash card _ _ _ Format removable drive

Reset to factory settings

| I [958Meq, 10.5% Uzed] W |

Change swap file

Exit . : : (&) Fomat as fatlE [suitable for dllmk2, dI2, a2

Format as fat3Z [zuitable for videod, diimk3, dlclub, dilpro,
o dilwp)

[ Faormat drive ] [ Cancel

e g 4 REHH.

File > Format flash card & MESIH AZEQ| T

s ME ¥ UEHS EW OO XEDt EWYAQ MeEp) FUT
DL1 Mk2 / DL1 SPORT / DL2 52 FAT16, DL1CLUB / DL1PRO / VIDEO4 52 FAT32
WINDOW 109M= ¢ A2 3iM= tEHT 1T WINDOW 7 THAITE TS ELCE 1

o N
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[ [958Men, 10.5% Used)

'@' Farmat as fat1B [suitable for dilmk2, di2, ax22)

Farmat az fat32 [zuitable for videod, diTmk3, dil club, dil pro
O ditwp]

l_ Format drive ] [ Cancel

@ Are you absolutely sure you have selected the correct disk? &ll information on this disk will be permanently lost!

(T R ETT

G WWINDOWSWsystemSZqurmat com

Format flash card®ll
HIolE EHAYMS| Ht

NS
WINDOW 10°IM= ¢l

I:O

H= A2 1Gb TIE 10= © ¥ UL,

QoM Bt BN M TS AP
12 M= SrEUYC

2
2
—_

WINDOW 7 THAIEH Ths B4
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e Analysis v8.5.403, [11

®[=N Data  Results  Window  Help

Load logged data
Load dats from database

KE @ E?

ddvanced load/saves r

Export as data,.,
Export as video,,,

Print setup
Print,.,
Print all,.,

Set default paths
Format flash card

Reset to factory settings

Change swap file

Exit

File > Reset to factory settings = ME{stH AZESIOE X[t & & RAEHH.



